A research support tool from ProQuest. P/I’O_ L@

&9 RefWorks 2.0

Simple. Powerful. Loved.

RefWorks 2.0 Quick Start Guide

Need More Help?

Online Tutorial
Tutorials explaining the features of RefWorks are available online at
www.refworks-cos.com/refworks/tutorials.

Logging In

¢ Access www.refworks-cos.com and click on the Login Center drop
down menu on top toolbar - select RefWorks. Enter your personal
Login Name and Password. (First-time users need to sign up for an
individual account following the screen prompts.)

® NOTE: Remote users, accessing RefWorks from off-site or from
a nonregistered IP address, must either enter the “Group Code”
prior to the personal Login Name and Password or log-in via the
organization’s proxy server.

Resource Center

Find materials provided by RefWorks and contributed by other
RefWorks users to help you get the most out of your account at
http://support.refworks-cos.com.

Support

Online
Use the Help pull-down menu to access detailed instructions,
frequently asked questions, administrator tools and much more.

E-Mail
Send questions or problems to support@refworks-cos.com.

Webinars

RefWorks offers complimentary training webinars in various
languages. Fundamentals and Advanced Features sessions are
available. A complete listing of webinar sessions can be found on
www.refworks-cos.com/training. New dates and times are added
monthly.

Phone
Contact RefWorks Technical Services at +1.775.327.4105.



Creating Your RefWorks Database

RefWorks provides a number of options for adding data to your database.

Importing Data Directly
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1. Under the save or export function within the online service, select
or click onto the save to RefWorks option. (A1)

2. If you have your RefWorks account already open, the import will
automatically begin. If not, then you will be prompted to the RefWorks
login page; after you login, the import will automatically begin.

3. Click the View Last Imported button to review the imported
records.

Helpful Hint: Every reference added to RefWorks (whether imported
or entered manually) is given a print or electronic designation called
Source Type. This assists in ensuring you have all the relevant data
required in your bibliography. A default Source Type may have been
set by your local Administrator. Users can set their own source type in
the Tools Menu, Customize area. (A2)

Converting References from Other
Bibliographic Management Products

RefWorks is compatible with a number of other bibliographic
management products. You can easily convert an existing bibliographic
management database such as EndNote into RefWorks. For details
related to importing data from specific individual bibliographic
management products, please refer to the online Help section of
RefWorks.

Technical Services support@refworks-cos.com

Importing Data from Saved Text Files
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References can be imported into RefWorks from a text file (.txt) created
by saving references from a wide variety of online services and other
bibliographic management programs.

1. Retrieve the results you want to export from the online service or
bibliographic manager, and save them to a text file. If the database
vendor lists several different formats for saving the references, see
the RefWorks Help file for further details on the appropriate
selection.

2. Access your RefWorks account and click References from the
drop-down menu; then select Import.

3. On the subsequent menu, access the drop-down menu next to
Import Filter/Data Source and click the source of the data. (B)

4. Click on the Database drop-down menu and select the source

database.

. Click on the Browse button to select the text file to import.

6. Click on the Import into Folder drop-down menu to designate the
specific folder where you want to file the imported references.

By default, references will automatically be placed in the Last
Imported folder, even if you pre-designate an existing folder for
them 1o go to.

7. Click on Import. When the import is complete, click the View Last
Imported button to review and modify the imported references.

o1

Helpful Hint: An up-to-date listing of all online services and databases
that are supported by RefWorks can be found on the RefWorks-COS
website at www.refworks-cos.com/refworks.

Importing from RSS Feeds

RefWorks has integrated an RSS Feed Reader so you can easily
add your favorite RSS Feeds from publishers and websites, view
the information and import data into your RefWorks database.

1. Locate the RSS Feed you wish to include.

2. Right mouse-click on the RSS Feed icon or link and select
Copy Shortcut.

3. From within RefWorks, select RSS Feed from the Search Menu.

4. Paste the shortcut into the text bar and click the Add RSS Feed
button.

5. Confirm the addition of the RSS Feed by clicking OK. Your
feed results will be displayed in a new window. Select the
references you wish to import into your RefWorks account and
click Import.



Creating Your RefWorks Database (continued)

RefWorks provides a number of options for adding data to your database.

Manually Entering References
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1. Click on the New Reference button.

2. Select a potential bibliographic output style (e.g., APA, Chicago, MLA)
under View fields used by to enable the AccuCite feature. (C)

3. Designate the type of reference you are entering (e.g. journal, book
or dissertation) under Ref Type. The field names that are
associated with the specific output style and reference type you
chose will appear, indicating recommended information needed
to produce an accurate bibliography. These fields are not required
to save the actual reference in RefWorks. To view additional fields,
click on Additional Fields on the bottom left of the window.

4. Enter information in the boxes provided and click the appropriate
Save button when finished.

Attaching Files to a Reference

® RefWorks

e v mewm ey Tees s

s Mo Pk | Cowt BBboguey | D Horw Haterence G Acress

H View Dekds wed by Hona Selacied -
. Wef 0123
L1 R84 1nTekder: Spacsy Foksars (Famy) -
o Faderisk P rgena &
et type: Scusmsd Aricle .

Sourcn Types (& Pres O Glactons
Oumgut | mmguage: Linknarem -

# actonecns: IOCAPOPRER poosyie WOCA Dorument| Brovse | [ A8d slachmure |
e N 5 O 1 N Py

You can attach files when adding a new reference manually or editing
an existing reference. Attachments can be any type of computer

file (PDF, TIF, JPG, GIF etc.) that you want to associate with the
bibliographic information you store in your RefWorks database. For
further instructions on attaching files to your references, please refer to
the Help file.

1. Select a reference in your database; click on the Edit button (Ei).
2. Click on Browse. Select a file to attach. Select Open.
3. Click on Add attachment. (D)

Helpful Hint: The number of files that you can attach to a reference
is determined by your local RefWorks administrator. The maximum
size of any individual attachment is 20 MB. (The default setting for
attachments in an account is 100 MB. The RefWorks administrator
may increase this setting up to 5 GB per account.) Note: The
Attachment Feature is no available for individual subscriptions.

Technical Services support@refworks-cos.com

Importing from Online Catalogs or
Databases
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You can use RefWorks as a search interface for a number of online
resources. (E) RefWorks provides access to a number of publicly
available services such as NLM's PubMed as well as many universities’
Online Catalogs. Additionally, institutional subscribers may also provide
access to subscription-based online services (e.g., Ovid or ProQuest)
through RefWorks.
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1. From the Search pull-down menu, select Online Catalog or Database.

2. Select a database from the Search drop-down menu.

3. Select the Max. Number of References to Download from the drop-
down menu.

4. Enter terms in either the Quick Search for: or run an Advanced
Search by clicking on the triangle in the Advanced Search for: box
to enter terms.

5. Click on Search to begin your search.

6. Your results will be displayed. Select the references you wish to
import into your RefWorks account and click Import. (F)



Managing and Sharing Your References

RefWorks provides you with a number of tools to organize, edit, find, and view references in your database.

Creating Folders
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1. Click on the New Folder button.
2. Enter a name in the text box; click Create. (G)

There is no limit on the number of folders you can create within your
RefWorks account.

Helpful Hint: The Last Imported folder contains only references from
your most recent data import that have not been filed in other folders.
References from imports prior to your last import not assigned to
specific folders remain available in your primary database but unfiled;
unfiled references are called References Not in a Folder and may be
seen by clicking the Folders tab.

Putting References into Folders
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1. Mark desired references from the search results page, then click
the button titled Selected. The selected references feature works
on a page-by-page basis; this means that you must add the
manually selected references to the desired folder before moving to
the next page. Alternatively, you can mark All or all on a Page.

2. Click on the Add To: folder icon ( |_g ) and select the appropriate
folder from the drop-down menu. (H)

3. References will automatically be added to the indicated folder.

Helpful Hint: References can be assigned to more than one folder.

Technical Services support@refworks-cos.com

Sorting References

1. From either the View pull-down menu or the Folders tab, select a
folder or group of references.

2. Using the pull-down menu Sort by, located in the main
navigational toolbar above the references, choose to view
references by various fields within your database.

Globally Editing References
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. From the main navigation area, click on the Global Edit button
)

. Select the appropriate option for References to Use.

. The Add option is displayed by default.

. Choose the specific field to edit from the drop-down list. (I)

. Type in the data you want to add to the field in the text field box.

. Select the appropriate option for handling the field - Append to
Existing Data; Overwrite Existing Data (what you currently have in
the field will be gone); Leave Existing Data Alone (if the field
contains data the edit feature will skip over that particular reference).

7. Click on Add Data.

OO Wi

Helpful Hint: RefWorks also offers the ability to Move, Delete, or
Replace information in records. For more information on these
additional Global Edit functions, please see the Help file.



Managing and Sharing Your References (ontinued)

RefWorks provides you with a number of tools to organize, edit, find, and view references in your database.

Quick Search

Use the Quick Search feature as a search of all fields. To produce
maximum results, all search terms entered are connected by the
Boolean connector OR. In addition, searches retrieve embedded
terms - a search for “art” retrieves references with “heart,” “part,”
etc. The results of a Quick Search are always ranked by relevancy.

1. Enter search terms in the Search your database box.
2. Click on GO.
3. Results are displayed with the search terms highlighted.

Helpful Hint: Only file attachments saved as .txt files or PDF files
saved in .txt format are searchable. To search file attachments, maek
sure the function to search attachments is enabled by clicking on the
paperclip icon (&) beside the search box.

Advanced Search

@® RefWorks

Advanced Search makes it easy to perform field-specific searches
(e.g., Author, Title, Descriptors), construct Boolean queries (i.e., AND,
OR, NOT), and limit the search to a specific folder(s). The results of

an Advanced Search are displayed alphabetically by author by default
(with the search terms highlighted) unless a customized sort setting has
been applied.

1. Click on the Search drop-down menu and select Advanced.

2. Enter search terms and corresponding fields into the
Advanced Search menu. Click on (&) to add more fields. (J)

3. Connect the terms by using the Boolean operators.

4. Select All References or specific folders to search.

5. Click on Search.

Helpful Hint: You now have the option to save search strategies.
Search strategies can be named and saved for easy and continual
retrieval.

Technical Services support@refworks-cos.com

Sharing Your References

@ RefWorks

Note: RefShare must be turned on by your local RefWorks
Administrator to be available. RefShare is not available for individual
subscriptions.

You can share a folder of references or your entire database.

1. Click on the Share tab from the main navigation area. (K)

2. Select the folder you wish to share by clicking on its Share icon
(I_.g). To share your entire database, select the Share icon in the
main navigation toolbar. Click OK. Note: Folders which have
already been shared will appear with a different icon ([F).

3. Click on the Options icon (| ﬁ ) to define any user restrictions you
wish to set for the RefShare Recipient(s). Click Save.

4. To share, click on the Email icon ([=]). A generic email template
and a unique URL created for your RefShare folder will open.
Insert the e-mail address of the individual(s) you would like to share
your references with. Select Send E-mail.

Helpful Hint: RefWorks users can directly export from a shared
folder to their own account, if permissible. As the owner of the
folder or database, you determine the control options your RefShare
Recipient(s) will have in utilizing your shared references.



Creating Your Paper and Bibliography

RefWorks creates bibliographies from over 1,000 output styles in seconds.

Format a Bibliography From a List
of References
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. Click on the Create Bibliography button.

. Select an output format (i.e., APA, MLA, Chicago, etc.).

. Click on Format a Bibliography from a List of References.

. Select what file type to create.

. Select to format all of your references or those references
from My List or from a specific folder.

6. Click on Create Bibliography.

7. A new window will open with your bibliography. (L)

8. Save your bibliography to your computer or disk.

Editing or Creating Your Output Style
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RefWorks provides hundreds of output styles to choose from. If
none of these styles conform to your desired results, the Output Style
Editor allows you to create custom output styles by either creating a
completely new style or modifying an existing output style to suit your
needs.

1. From the Bibliography pull-down menu in the toolbar, select Output
Style Editor.

2. Select the appropriate Style to edit from the drop-down menu or
click on the New button. (M)

Access the Help menu for additional assistance in creating or editing
new bibliographic output styles.

Technical Services support@refworks-cos.com

Write-N-Cite Paper
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Note: Write-N-Cite will not reflect the RefWorks 2.0 interface design
until late 2011.

Create a paper with in-text citations using the RefWorks Write-N-Cite
feature.

—_

. Open a new blank document in Microsoft Word.

. Launch Write-N-Cite. (N)

3. Put the cursor in your Microsoft Word document where the
reference should be inserted:; click Cite next to the reference in the
RefWorks screen.

4. Save your Microsoft Word document when finished.

N

Helpful Hint: Write-N-Cite Il now allows you to work on a paper

and format a bibliography both on- AND off-line. Write-N-Cite Il is
only available for Windows Users. Write-N-Cite v2.5 is available for
Mac Users. To use Write-N-Cite, download the utility from the Tools
pull-down menu before using. To utilize the off-line capabilities, you
must first download your database while online. For more information,
please refer to the Help file.

“This pagier will demonetrate the capabilities af Write--Cite IT1 {{372 BeutlerSteve 2008}, Write-X-
Citehelps nsers {{54 Dudek.A.Z. 2008; 69 Ferrando-Lucas, M.T. 2008} } with in-text citations { {52
Gutstein B, 1008} | end bibliographies | {94 Hall 5.5, 2008} |
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1. Launch Write-N-Cite.

2. Click on Bibliography and select the output style. (0)

3. Click on Create Bibliography. The document will refresh to be
formatted correctly and contain the bibliography.

4. Save your Microsoft Word document.



Creating Your Paper and Bibliography

RefWorks creates bibliographies from over 1,000 output styles in seconds.

One Line/Cite View Paper
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1. Click on the Cite icon (- 1) on the right side of the appropriate
reference. A Citation Viewer window will appear containing the
citation in an abbreviated format.

2. To cite a second reference in the same location just click on the Cite
icon by any other reference. If you are using a Mac, you will need to
click twice - the first click will activate the RefWorks program and
the second will perform the Cite function.

3. Once you have all of the references you need for a particular in-text
citation, click on the Select button. (P)

4. Simply drag and drop the citation into your word processor
document. Alternatively, you can also go to our word processor,
click on the document where you want the citation inserted and
Paste the citation.

5. Be sure to clear the Citation Viewer window before creating your
next citation.

6. Click on the View icon (") to see the entire reference and to
access the Edit command if you want to make changes.

One Line/Cite View Bibliography

1. Save the document you have just created before formatting the

paper and the bibliography.

. Click on the Bibliography button from within the RefWorks program.

3. Select the Output Style you need and use the Format Paper and
Bibliography option to browse for the document.

4. Simply drag and drop th ecitation into your word processor
document. Alternatively, you can also go to our word processor,
click on the document where you want the citation inserted and
Paste the citation.

N
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Direct Exports Available From:

-ABCCLIO

- ACS Publications

- bibliotek.dk

- BIBSYS

- BioMed Central
-BioOne

- Blackwell Synergy
- CABI

- CAIRN

- Chadwyck-Healey
- Compludoc

- (Q Press

- CSA lllumina

- CSIC

- DanBib - Danish Bibliographic

Centre

- Dawson Books
-DBPIA

- Deep Web Technologies
- Dialnet

-ebrary

- EBSCOhost

- Engineering Village 2
-FIS Bildung

- Google Scholar

- GoPubMed

- Highwire

-HubMed

- |IEEE

- Informit

-Japana Centra Revuo

Medicina (Web)

-JSTOR

- LexisNexis Academic
- MetalLib

- Microsoft Live Search Academic
-Newsbank

-NISC

-0CLC

-OCLC PICA - ZPORTAL
-0vid

- Project Muse

- ProQuest

-QUOSA

-RISS4U

*RLG's Eureka

-Sabine

- ScienceDirect

- Scitopia.org

-Scopus

- Serials Solutions
-SFX

- SilverPlatter

- Stat!Ref

-The R2 Digital Library

(Rittenhouse Book Dist.)

- TDNet
-TicToc
- Thomson Gale via Open

URL Link

- Ulrich’s Resource Link

- University of California Press
-Wanfang Data Corp.

- WebFeat

- WilsonWeb via WilsonLink



